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Introduction 

Welcome to Unit Standard 107 v6 Apply text processing skills to produce communications in a 
business or organisational context with Microsoft Word 2013. 
 
This book has been written using Microsoft Word 2013 with Windows 8. (The Windows 7 
operating system can be used. However screen shots will differ slightly from those shown in 
this book.) 
 

Default Settings 
Before commencing this course you will need to check (and amend if necessary) the default 
settings for Word 2013 as described on pages viii to x.  This will ensure that all exercises and 
instructions in this book will work exactly as they should.   
 

Retrievable Exercise Files 
Some exercise files have been created for you to prevent time in keying in many exercises.  You 
can then open these files and use the features of Word to manipulate and format text.   

A list of these files is shown on page xiv and instructions for downloading these files from our 
web site are included on page xv. 
 

What you will learn 
In this course you will learn how to - 

 apply text processing skills to produce communications in a business or organisational 
context 

 edit, format and display documents attractively 

 produce a variety of documents including essays, assignments, memoranda, 
correspondence, newsletters, reports, notices, advertisements, forms, email 

 compose documents from drafts and notes 
 

How you will learn 
This book is divided into sections.  Each section page lists the learning outcomes for that 
section.  You will work through each section and do all exercises (or those instructed by your 
tutor).   

A Practice Assessment included at the end of the section.  Our books include accumulation and 
consolidation of learning which carries across each section.   
 
After you have completed the book your tutor will give you the actual Unit Standard 
Assessment.   
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Word meaning boxes 
Sometimes you will see a box at the left side of the page of a line that has dotted underlining. 
This box will contain information to help you understand the meaning of the underlined word 
(or how that word is formed).  An example is shown below. 
 
Data can therefore be altered to re-calculate budgets and to forecast results using different 
sales figures.  Worksheets can be saved, opened and printed as required. 
 

Different Word buttons 
Depending on the size of your Word screen buttons on the ribbon may vary to those shown in 
this book.  The icon with the word of that feature may show, or the icon only. 
 

For example, the Copy button in the Clipboard group on the Home tab may be displayed in 
either of the following ways. 

  OR   

The Symbol button can show as either - 

 OR  
 

Shortcut keys 
Shortcut keys are indicated in the left margin, usually the first time they are used.  An example 
follows. 

1 Click on the Save button  on the Quick Access Toolbar  . 

2 Type a file name for your document then click on Save.  
 

Glossary 
Generally when a word(s) is first used that is a technical term or a word that you may not know 
that relates to an exercise, or a particular Word 2013 feature, a description is given.  You will 
also see that such words are in bold.   

These terms are listed on each section page, an example is shown below.  Explanations are also 
included in the Glossary at the end of the book. 
 

 

 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

AutoCorrect Format Replace 
Clipboard Microsoft Office Help Selecting Text 
Correction Signs Move Text Synonyms and Thesaurus 
Cut Navigation Pane Typing Replaces Selection 
Drag and Drop Proof-reading Undo 
Find Redo  

  

forecast  
=  to 
calculate a 
future 
result  

Ctrl S 
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Icons used in this book 

This book contains icons to help guide you in your learning.   

The following list shows the icon and its meaning. 

 

 Learning Outcomes 
Learning Outcomes are displayed on the section page and describe what you will learn in that 
section. 

 
 

 EXERCISE 1 
These are the exercises that you are required to do.  Often there will be an introduction 
sentence to tell you what you will be doing in that exercise.   
 
 

These are notes for your information. 

 
 
 

 Practice Assessment 

Each practice assessment covers consolidation of topics learnt in that section and provides 
practice for students prior to sitting the actual Unit Standard Assessment. 
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Changing Defaults 

Default settings may have already been changed in your Word 2013 program.  If not, you can 
use the following instructions to change these. 

Font and Font Size 
You can check if the font and font size have been changed by looking at the Font box on the 

 tab.  If it shows  then it has not been altered.  Change the default 
font to Arial 11 pt as follows: 

1 Click on the Font Dialog Box Launcher  which will display the 
Font dialog box. 

2 Change the Font: to Arial and the Size: to 11 pt. 

3 Click on . 

4 Ensure the following option is selected for the font to be applied to All documents based 
on the Normal template.  

 

5 Click on OK. 
 

Spacing 

 Click on the  tab and if 10 pt Spacing After is displayed as shown below then 
this has not been altered.  (Use the instructions below also if 8 pt After is displayed.) 

 

Remove 10 pt spacing as follows. 

1 Click on the Paragraph Dialog Box Launcher  which will 
display the Paragraph dialog box.   

2 Change the Spacing After: to 0 pt as shown below.  

 

3 Click on .   

4 Ensure All documents based on the Normal template is selected then click on OK.   

  

Sa
m

pl
e D

oc
um

en
t



 

ix 

Margins 

 On the  tab click on the Page Setup Dialog Box Launcher 
 which will display the Page Setup dialog box.   

If margins are displayed as 3.17 cm change them as follows.  (If they have been changed to 
those shown below click on Cancel.) 

1 The Top: margin will be selected, ie .  Type:  2.54 then press the Tab 
key.  Repeat this until the margins are displayed as shown below. 

. 

2 Click on .   

 

3 Click on Yes.   

 

 

Bullets and Numbering 
When bullets and/or numbering are inserted in Word 2013 a style is applied to these features.  
This can prevent spacing before and after, or spacing options to be used with the Line and 
Paragraph Spacing button.   

You will therefore change bullets and numbering to be applied using the Normal style as 
follows: 

1 Click on the  tab and select . 

2 Click on  at the left. 

3 Ensure a tick is displayed in the following . 

4 Click on OK. 
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Dictionary 
Microsoft Office 2013 does not have an inbuilt dictionary.  We recommend that you download 
the Bing Dictionary as instructed below.  

(If another dictionary has already been added captures in our Word 2013 books will be very 
similar but may not be exactly the same.) 

You will need to be connected to the Internet to be able to download the dictionary and to use 
it. 
 

1 Click on the  tab then click on . 

2 In the Apps for Office dialog box click on which will take you to the 
Microsoft Apps Store.   

(If other apps have been installed you need to click on . 

3 In the Search box at the top of the window type dictionary as shown below. 

 

4 Click on the Search button . 

5 Click on the following dictionary which we have selected because it is FREE and has the 
highest star rating.  It can also be used in Excel 2013. 

 

6 Click on  then on  

The Bing Dictionary will now show on the  button and will be used for spelling and 
grammar checking, synonyms and thesaurus. 
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Save Options 

When a document is saved you will be requested to select the location, ie Computer then click 
on the Browse button and select the folder required.  You can eliminate this procedure by 
selecting the location and saving directly to the Save dialog box and therefore bypass Backstage 
view.   

For the purposes of this book we have used My Documents folder as the default folder.  This 
means that files you open and save will be on your hard drive. 

 

If you wish to open and save files to SkyDrive (ie the cloud) use instructions on the next page. 

 
Use the following instructions to specify My Documents as the default file location: 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the Documents folder is displayed as the Default local file location as shown 
below.   

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 

5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

 

6 Click on OK. 
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SkyDrive 
SkyDrive is a cloud storage application from Microsoft.  It is one of the major online file storage 
options competing with Dropbox and Google Drive. 

Because files are stored “in the cloud” it means that you can access those files from anywhere 
in the world because you will always have access to the SkyDrive application and your files.  You 
do however need an Internet connection to be able to update those files. 

 

 
Saving to SkyDrive 

SkyDrive is automatically set up when Microsoft Office 2013 (ie Office 365)  
is installed on your computer.  A SkyDrive folder will be displayed on the 
Navigation Pane in Windows Explorer as shown at the right.   

Files can be saved manually by clicking on the Save button  on the Quick 

Addess Toolbar, specifying a name for your file then clicking on the  icon (you may 
wish to double click on Documents and save to that folder). 
 

SkyDrive as the Default File Location 

Use the following instructions if you wish to specify SkyDrive as your default file location. 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the Documents folder is displayed as the Default local file location as shown 
below.   

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 

5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

6 Click on  at the right of Default local file location: and select . 

 

7 Click on OK. 
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SkyDrive Website 

You can log in to the SkyDrive website using your web browser with your login name and 
password. 

The website is www.skydrive.live.com. 

 

You can upload photos and use files and share files. 

New files can be created through SkyDrive by clicking on  and selecting the 
program you wish to use, eg Word (web applications in SkyDrive are slightly cut-down 
versions of Office 2013 programs). 

 

 
Sharing Files 

From within Word 2013 you can save files to SkyDrive (usually to the Documents folder).  You 

can then click on the  tab, on  and invite people to share files in SkyDrive.  (For 

further information click on the Help button  in the Share screen.) 

Alternatively, you can right click on a file in the SkyDrive website (see above) and select Sharing. 

Use Google in your web browser to search for additional information on SkyDrive.  
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Exercise Files used in this book 

 
(Instructions are included on the following page for downloading retrievable files 

from our web site at www.cherylprice.co.nz) 
 
 

Names of files 

Advertisements Maori 

Body Shape Planting 

Email Retention Rates 

Freezers Second-hand Shops 

Garden Designs Supreme Property Service 

Hire Purchase William 

Jan Jasmine Windows 8 

Layout Exercise Words and Figures 
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Downloading Exercise Files 

The exercise files listed on the previous page can be downloaded from the Cheryl Price web 
site using the instructions below. 

Exercise files can be downloaded to My Documents folder OR SkyDrive.  However, for the 
purposes of this book we have specified My Documents as the folder for saving and opening 
files.  If you are using SkyDrive simply use the SkyDrive folder instead. 
 
 

  

  

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 Click in the Product Search box and type the number of 
this unit standard, as shown at the right. 

4 Click on     

5 Click on   

6 Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files – V6 Word 2013  Free Download 

The File Download dialog box will display.   

7 a Click on then click on the Documents folder shown below at the 
left OR on SkyDrive shown below at the right. 

 

    

b Click on . 

8 a Click on .   

b Right click on the zipped exercise file and select Extract All.  Click on Extract.   

 A folder will be created containing the exercise files.  

c Delete the Compressed (zipped) Folder. 

US 107 

US 107 
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NZQA Outcomes and Evidence Requirements 

Unit Standard 107 Version 6 
 

Title Apply text processing skills to produce communications in a business 
or organisational context 

Level 2 Credits 5 

 

Purpose People credited with this unit standard are able to apply text processing 
skills to produce communications in a business or organisational context. 

 

Classification Business Administration > Business Information Processing 

 

Available grade Achieved 

 

Explanatory notes 
 
1 All activities associated with this unit standard must comply with occupational health 

and safety guidelines and recommendations in relation to working environment and 
work practices.  Reference for this unit standard includes OSH 3211 AFC: 1996 
Approved Code of Practice for the use of Visual Display Units in the Place Of Work.  
Occupational Safety and Health Service: Department of Labour, available at 
http://www.osh.govt.nz/order/catalogue/pdf/vdu-ac.pdf. 

 
2 Definition 
 Text processing conventions refer to accepted practices of display for page layout, use of 

white space, consistency, and spacing.  Conventions used must produce documents that 
are fit for their intended use and meet organisational style requirements. 

 
3 Evidence of text processing skills and editing must include the following features, which 

may be demonstrated once over all five communications rather than in each – 
amended text, deleted text, copied text, moved text, use of additional information, use of 
page and paragraph numbering. 

 
4 Spelling, grammar, vocabulary, and punctuation in the documents must be consistent with 

the nature and purpose of the business or organisational information required.  
Candidates must be given the opportunity to proofread their work prior to submission. 
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Outcomes and evidence requirements 
 
Outcome 1 
 
Apply text processing skills to produce communications in a business or organisational context. 
 
Range communications may include but are not limited to – essays, assignments, 

memoranda, correspondence, newsletters, reports, notices, advertisements, forms, 
email;  

 evidence is required for five different types of communication. 
 
Evidence requirements 
 
1.1 Spelling, grammar, vocabulary, and punctuation are consistent with the nature and 

purpose of the communications required. 
 
1.2 Page layout, format and display of communications are consistent with the output 

required, and meet organisational style requirements. 
 
1.3 Communications are composed from drafts and notes in accordance with 

information provided and output required. 
 
1.4 Use of words and figures is consistent with the nature and purpose of the 

communications required. 
 
1.5 Communications are produced in accordance with text processing conventions. 
 
 

Planned review date 31 December 2015 

 
Status information and last date for assessment for superseded versions 

Process Version Date Last Date for Assessment 

Registration 1 30 March 1993 December 2011 

Review 2 27 June 1996 December 2011 

Review 3 28 April 1997 December 2011 

Review 4 28 June 1999 December 2011 

Review 5 26 September 2005 December 2012 

Review 6 17 December 2010 N/A 

 

Accreditation and Moderation Action Plan (AMAP) reference 0113 

This AMAP can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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© Cherylprice.co.nz Limited SECTION 1    1 

 
 

Introduction to Word 2013 
Ergonomics 
 

 
 

 

 Learning Outcomes 
 

At the end of this section you should be able to -  

 Start and Exit Word 2013 

 Understand the basics of Word 2013 

o Live Preview 

o Screen Tips 

o Mini Toolbar 

o The Ribbon 

o Dialog Box Launchers 

 Check your workstation for ergonomic layout 

 Take appropriate exercises and breaks when using a computer 

 
 
 
 
 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

Contextual Commands 
Copy-Holder 
Defaults 
Dialog Box Launcher 
Ergonomics 
Foot-rest 
Live Preview 
Maximize 

Micropause 
Mini Toolbar 
Minimised 
Minimize 
OOS 
Quick Access Toolbar 
Restore Down 
Ribbon 

Screen Tip 
Scrolling 
Tabs 
Taskbar 
Workstation 
Wrist Rest 

 

Section 

1 
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2    SECTION 1 © Cherylprice.co.nz Limited 

Introduction 

Unit Standard 107 is about producing text processed communications in a business or 
organisational context (eg emails, letters, faxes, etc) that are fit for their purpose: 

 Spelling, grammar, vocabulary and punctuation must be consistent with the nature and 
purpose of the business or organisational information required, 

 the text should be displayed appropriately in terms of formatting, page layout and 
consistency, 

 the communications should meet organisational style requirements. 

You will be using Microsoft Office Word 2013 to create and edit text, including copying, moving 
and deleting.  You will also create documents based on instructions and notes given to you. 

There are exercises that allow you to practise these skills, including an assignment at the end 
of each section where you should show consistency and proficiency in layout of each of the 
documents. 
 
This book uses Word 2013 running on the Windows 8 operating system. 
 
This section mostly follows a step by step format to help you with learning Word 2013; the 
following sections will present you with tasks to complete and general instructions. 
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Word 2013 

Microsoft Office Word 2013 is the word processing program in the Microsoft Office 2013 suite 
of programs.  It looks and works in a similar way to Word 2010. 

Many of the changes are intended to make it easier to use, so if you are new to Microsoft Word 
you should find it an easy program to learn. 
 

For the rest of this book the program will be referred to as Word 2013. 

 

Starting Word 2013 

 EXERCISE 1 

1 If the Start screen shown below is not displayed click on the Windows key  on your 
keyboard. 

OR move your mouse pointer to the very bottom left of the window 
where the Start button shown at the right is displayed.  
 

 

2 Click on the  as shown above to scroll across the screen. 

3 Click on the Word 2013 program icon shown below.  

 
  

Click here to 
scroll across 
the screen 

Click here to display 
the Start button Sa
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Microsoft Word will open.  If Word 2013 has been used previously then Backstage View 
will be displayed as shown below.  (Recent documents are shown at the left.) 

 

4 Click on Blank document as shown above.   

The screen will display with a new document, ready for you to enter text. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

The  tab contains all basic tasks such as opening, saving and printing a document. 
 

 
   

File tab 

Group 

 

Rulers 

 

Note:   
If Rulers are not displayed click 
on the View tab then click in the 

Ruler check box. 

 

Quick  
Access 
Toolbar  

Insertion point 

Ribbon 

Vertical 
Scroll Bar 

Vertical 
Scroll Box 

Help 
Ribbon Display 
Options Minimize 

Restore 
Down 

Close 

Status Bar Document Views Zoom Controls 

Tabs Title Bar 

Rulers 

 

Note:   
If Rulers are not displayed 
click on the View tab then 

click in the Ruler check box 
 

Blank  
document 
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Opening a Document 

 EXERCISE 2 

1 Click on  at the top left of the screen.   

2 Click on . 

3 Click on then click on  to search for your file.   
 
Your files will be saved to the My Documents folder as 

shown at the right (OR to under Favorites).  

The Open dialog box will display the exercise files that are 
included with this book.  The display of your files may be 
different. 

The view of your files can be changed by clicking on the  of the Change your view 
button shown below. 

(The following view is .) 

 

3 Look at the different views that are available. 

4 Click on the file called Windows 8. 

5 Click on . 

   

Change your  
view button 

Ctrl O 
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Live Preview, Screen Tips and the Mini Toolbar 

 EXERCISE 3 

1 Ensure that the insertion point (flashing cursor) is in the heading Windows 8 and move 
your mouse cursor over Heading 1 in the Styles gallery – do not click on the style.   

Live Preview will show you how the heading will look with Heading 1 style applied. 

 

2 Move your cursor away from the Styles gallery and the preview will disappear. 

3 Move your cursor over the Heading 2 style to view the Live Preview (again, do not click on 
the style).  Move the cursor onto the Subtitle style. 

4 On the  tab, move your cursor over the Justify 
command in the Paragraph group.  A detailed screen tip will 
display. 

5 Move your cursor over other commands to view their screen 
tips. 

6 Click and drag your cursor over the heading Windows 8 to 
highlight it.   

The Mini Toolbar will display just above the text, with commands for the quick formatting 
of the selected text.  The toolbar will become fainter and disappear if you move your cursor 
away from it. 

 

7 Click on the Italic button  

8 Click anywhere else in the document to deselect the text.  The Mini Toolbar will disappear. 

9 Keep the file open for the next exercise. 
 

The Mini Toolbar will also display above or below the shortcut menu if you right click on text.  
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The Ribbon 

Tabs 
The tabs are used to display different sets of commands. 

 
 

 EXERCISE 4 

1 Click on the  tab to view the commands on that tab.  The ribbon will display a 
totally new set of commands. 

 

2 Click on the other tabs to view their relative commands on the ribbon. 

3 Click on the  tab. 
 

Contextual Commands 
Some commands only appear when you need them, or in certain views. 
 

 EXERCISE 5 
1 With the Windows 8 document open, click on the picture of the computer to select it.   

 

A new heading will display at the right end of the ribbon, highlighted pink, 
with a new tab underneath it, as shown at the right. 

2 Click on the  tab.  A set of commands for formatting the selected 
picture will display. 

 

3 Return to the  tab. 

4 Click anywhere in the document to deselect the picture.  The contextual tab will disappear. 
Keep the file open.  

 If you had inserted the picture yourself (using commands from the  tab), the 
commands on the Format tab would have displayed automatically without having to click on 
the tab. 
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Dialog Box Launcher 
A Dialog Box Launcher is located at the bottom of some groups on the ribbon.  It is used to 
display dialog boxes that have further commands. 
 

 EXERCISE 6 

1 Select the heading Windows 8. 

2 On the  tab, click on the Font Dialog Box Launcher at the bottom right of the Font 
group.   

 

The Font dialog box will display as shown below. 

 

The Font dialog box can be used to apply many formatting commands to selected text in 
one go.  It has many additional options that are not in the Font group on the ribbon. 

3 Click on the  of the Font: list to view more of the list of fonts that are available.   

4 Drag the scroll box downwards. (This action is known as scrolling and can also be applied 
to the scroll bar at the right of the screen to view different parts of your document.) 

5 Try some of the options in the Font dialog box - the Preview section will display the text 
sample with those options applied. 

6 Click on  to close the dialog box.   

7 Keep the file open. 
  

Ctrl D 
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Minimising and Restoring the Ribbon 
To give you more space for typing or viewing your document, the ribbon can be minimised so 
that only the names of the tabs are displayed. 
 

 EXERCISE 7 

1 Ensure that the  tab is displayed and the insertion point is in the heading 
Windows 8. 

2 Click on the Ribbon Display Options button at the top right of your screen.  This will 
display the following options for hiding/displaying ribbon options. 

 

3 Click on Show Tabs which will display the ribbon minimised as shown below. 

 

4 Try each of the other two options on the Ribbon Display Options button. 

5 With Show Tabs and Commands selected click on the Center button  in the Paragraph 
group.  The heading will be centred on the page. 

6 Click on  then click on .   

7 Click on  when asked if you want to save the changes. 

 

If you double click on a tab the ribbon will show tabs only.  Double clicking a second time will 
display the tabs, commands and ruler. 
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Customising the Quick Access Toolbar 

The Quick Access Toolbar is a useful feature for keeping all of your most frequently used 
commands in easy reach.  Commands from previous versions of Microsoft Word can also be 
added.  The toolbar itself can be positioned either above or below the ribbon. 
 

 EXERCISE 8 

1 Create a new document. 

2 Click on the Customize Quick Access Toolbar button  to the right of the Quick Access 
Toolbar as shown below. 

 

3 Ensure all the commands shown below are selected. 

 

4 Click on the Customize Quick Access Toolbar button   again and select More 
Commands… 

The Word Options dialog box will display with Customize the Quick Access Toolbar option 
selected. 

5 Click on the  of the Choose commands from: box and select File Tab as shown below. 
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6 Click on from the left hand list then click on .   

The command will be added to the Quick Access Toolbar list at the right. 

7 Add the following commands in the same way: 

Print Preview Edit Mode  
Save As 

8 Click on the  at the right of File Tab and select All Commands.  Add any other commands 
that you use often.  (I have added AutoText and Wrap Text.) 

9 The Move Up and Move Down buttons shown at the right of the dialog box can be 
used to rearrange the display of buttons on the Quick Access Toolbar.  Rearrange 
the buttons so they are in a logical order – an example is shown below. 

 

10 Ensure a tick is displayed in the option shown below.  

 

The toolbar will display below the ribbon, just above the document.  The position that 
you display your Quick Access Toolbar is entirely up to you.   

To remove a command from the toolbar list click on it then click on . 

You can click on  to quickly revert back to the original set of commands (Save, 
Undo and Redo). 

11 Add any other commands that you find useful – you can progressively add commands as 
you work through this book.  

12 Click on OK. 

(From your typing screen you can click on the  of the Quick Access Toolbar and select 
Show Above the Ribbon or Show Below the Ribbon as required.)   
 

The commands that you have added in this exercise will be used throughout the remainder of 
this book.  You can continually add commands that you find useful. 
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Minimize, Maximize/Restore Down, Close 

The three buttons at the top right of the window are used to control the display of the entire 
window. 
 
 

 

 

The Minimize button places the current Word document within the Word icon on the Taskbar 
as shown below.   

 

If more than one document is open then a miniature of each document will be displayed as 
shown below (or just the filename(s) depending on your setup). 

 

When the window is maximised (ie fits all the available screen) the Maximize button will display 
as the Restore Down button. Clicking on Restore Down will reduce the size of the window. 

When the window is reduced in size and does not fit the entire screen, the Restore Down 
button becomes the Maximize button – click on this button to revert to the full screen view. 

Clicking on the Close button  at the top right of the screen will close the document and exit 
from Word 2013 if only one document is displayed – you will be prompted to save any changes 
that have not been saved. 
 
 

  

Close 

Restore 
Down Minimize

  

Maximize 

revert 
=  return 
as it was 
before 
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